Welcome to this Creative Studio CS5 Superguide. Here you will find a wealth of information on Adobe's latest release.

This is our second Superguide following the huge success of the CS4 Superguide. Expect a Superguide from each time Adobe has a major release of a new Creative Suite. Count this as part of your exploration process.

Check out our coverage of Photoshop CS5, Camera Raw 6, Illustrator, InDesign, Flash, After Effects, Premiere and more. We have assembled some of the best experts in the industry to write these articles for you. While we didn’t manage to cover every application, we got really close. There have been many sleepless nights and favor-calling to make this a reality. I have managed to assemble a very elite group of people, some of the smartest minds in the business, including Jack Davis, Jane Conner-Ziser, Wes Maggio and David Blatner. Each contributor is an expert (In many cases the top expert) in their chosen application.

We also plan on making Creative Studio a regular free publication. Thanks for your patience and support. Also thanks to your support of PhotoshopCAFE.com. Thanks to you, we are celebrating our 10th year as a leading online resource on Photoshop.

If you aren’t a subscriber on our mailing list, make sure you join up so you don’t miss any of the exclusive tips and discounts only on our mailing list. (If you signed up for this Superguide you’re already a member, it’s free!)

Also check out the free videos on Photoshop CS5. A lot of the content here has also been compiled into a CS5 microsite at www.PhotoshopCAFE.com/cs5; there are also some videos and other goodies there.

Your partner in success,

Colin Smith
Publisher
csmith@photoshopCAFE.com
Photoshop CS5 New Features (aka Photoshop 12) By: Colin Smith

Photoshop is the cornerstone of the Creative Suite. Almost every creative professional leans heavily on the use of Photoshop. Designers, Photographers, 3D artists, Video, Visual Effects, Illustration, even forensic scientists, dental, medical and scientists are using Photoshop. It's a word regularly used on TV and films, it's part of pop culture. Everyone has heard of Photoshop and millions of people are using it.

So what does Adobe have up their sleeve this time? What wizardry has been engineered into our favorite app to make it our even more favorite app. What have they injected into CS5 to make us want, no HAVE to rush out and get the upgrade? That's what you will discover as you read this article. I'll attempt to give you a look at what's new and also report what it's like to use. Any features that will change your life, or any tips to save you time? Read on.

64 BIT AND GPU

What's worth mentioning is that Photoshop is 64 bit native on Mac and Windows. Actually all the Adobe CS5 products are 64 bit. What does this mean? It means a performance boost. Not the type you are perhaps thinking though. 64 bit removes the 4Gig of RAM bottleneck. So if you are working on large files, or files consisting of multiple composited images, you will be able to take advantage of more RAM. Also on the performance end of things is the extensive use of the GPU (Graphics Processing Unit). This takes a lot of the graphical load off of the main processor (CPU) and reroutes it to the Graphics card. The GPU is equipped to run these types of processes with effortless ease. So not only results in faster screen redraws, smoother painting etc. but it also opens up the options for on screen resizing of brushes, live updates, faster scrolling, redraws and zooming.

For example, with the Brush tool selected, hold down Control+Command on Mac and drag side to side to change the brush size. Drag up and down to change the softness.

Hold down the alt/Option key while the brush is selected to sample a color. The new Color wheel displays with the current and selected colors visible.

On top of this, the CPU is able to perform more work because of the helping hand of the GPU. I highly recommend looking into the NVIDIA line of cards for a fast upgrade. The Geforce line is a good cost effective way to gain extra performance. For the power user, consider the Quadro FX models.

THE GOOD STUFF

Don't worry though; there are plenty of sexy additions too. Check out HDR Pro, the Puppet Warp tool, Content Aware Fill, the new Refine Edge tools, new RAW engine, new brushes and paint mixer and much more. Let's get started with the Refine Edge tool.

MAKING SELECTIONS

You may well remember that the Refine Edge and Quick Select tools were added in CS3. You also noticed that in CS4 there was a disappearance of the Extract tool. That's because Adobe had something up their sleeve in CS5. There is a completely different way that Quick Selection and Refine Edge work together in CS5 and it was worth the wait. It's now really fast and easy to get great looking selections, even on things like hair and fur. This may be my favorite new feature in CS5.

Start by using the Quick Select tool to make a selection. Remember to hold down Alt/Option to remove from a selection if you get a little too heavy handed.

With the selection active, switch to Refine Edge, you can see it in the Options bar. You will see lots of new options. While refining selections, you will work in the top part of the panel. Notice there is a pull down menu with lots of viewing options.

Here is a little tip to simplify the process. Click Hold down Control+Option+Cmd on Mac (Right Click+Alt+Ctrl Windows?) with the brush selected. You get an on screen color picker with Hue/Saturation and Brightness ramps. Very nice!

Photoshop CS5 New Features (aka Photoshop 12) By: Colin Smith
Finally, you get to choose how the selection will be applied to the image. You can apply just as a selection; copy the selected object to a new layer; add it as a Layer Mask; create a new Layer with a mask or even a new document. This is really nice and allows for a flexible workflow. What I really like about this, is that it really works. I was able to get faster, cleaner edges than ever before.

CONTENT AWARE FILL
Ok, this next feature is really freaky. You may have seen it before because Adobe leaked it to the public a couple of times before the launch. How about a magic retouching tool?

Simply put, you have something you want removed from a picture, don’t reach for the Clone Stamp (anymore). Make a rough selection with the lasso tool. Then choose fill (Keyboard Shortcut is Shift+Delete, Shift+Backspace on PC). Select the option Content Aware from the drop down menu and click Ok. Wait a few seconds. Then like magic the object is removed and replaced by the texture of the background. This is a random effect with no real options, it either works on the image or it doesn’t.

HDR (HIGH DYNAMIC RANGE)
First of all, let me clear up a misconception of what HDR is. The human eye is capable of seeing more details in shadows and highlights simultaneously than a camera. The range of light to dark with visible detail is called the dynamic range.

This image shows what typically happens in a high contrast scene. Notice that the exposure is pretty good. However, I was unable to capture the detail outside because it’s too bright. Also some of the shadows are plugged up because they are too
The solution is to shoot a series of photos that covers the entire dynamic range. In this case I took 7 shots, each of them 2 stops apart. (Each F stop is double the brightness of the previous.)

Using the new HDR Pro (a beefed up Merge to HDR) we are able to merge the Photos into a 32 bit image.

There are some significant enhancements in HDR in Photoshop CS5.

Anyone who knows anything about HDR knows that Photoshop is the best tool for merging images into HDR. I have heard some instructors, mistakenly suggest using Photomatix for merging. (Bad idea, because Photomatix converts RAW to JPG at merging point, thus throwing away ½ the dynamic range. Now Photomatix for tone mapping is a different story altogether).

When there is movement between Photos (camera shake, or blowing clouds, leaves or water etc), doubling (also called ghosting) occurs.

A new feature in CS5 is the Remove Ghosts button. When you click this, Photoshop does a pretty good job of de-ghosting. Notice that there is a green box around the de-ghosted image.

Try clicking a different thumbnail to set a different de-ghost and produce a very different result.

dark. This is known as a Standard or Low Dynamic Range image. It’s a RAW file. With some adjustments, I could coax some extra detail out of the shadows, but the Highlights are totally gone.

Let’s shoot another couple of photos. First of all, I set the exposure for the outside area. Notice how dark the interior is now.

Or how about another exposure to show all the detail in the iron banister. Notice that many parts of the photo are now over-exposed.

TONES MAPPING

The 3rd part and the magic of HDR is the Tone Mapping. You can’t use a 32 bit image so we need to choose the tones to display the photograph. Photoshop now includes a decent Local Adaption for tone mapping. In the past we had to use programs such as Photomatix to do high quality Tone Mapping. There is still a place for Photomatix, but Photoshop now does a pretty decent job of Tone Mapping.

Photoshop CS5 excels in natural looking Tone Mapped HDR photos and contains lots of options to get the image looking the way you like.

You can also use it to create surrealistic looking images that people either love or hate. I personally like them when done correctly, which sadly is rare.

It takes a keen eye and some skill to produce a surrealistic HDR that isn’t ruined by halos and oversaturation. Check out my full tutorial and DVD for more on HDR.
HDR TONING

This is a filter than can produce a stylized HDR “looking” result on a single image. Personally, I don’t like the name HDR, because it’s not possible to create a single image HDR. “Wait!” you might say, “I’ve seen single image HDRs, or Pseudo- HDR.” Reread the explanation of HDR again and you will notice a photo isn’t an HDR because of the Tone Mapping, it’s because of the Dynamic Range. A single photo will always be SDR (Standard Dynamic Range) no matter what you do to it. It’s like taking a mono signal, playing it through 2 speakers and then calling it stereo.

Having cleared that up, the HDR Toning tool does a good job of simulating a tone mapped look on a LDR image. For what it does, it does well, just don’t expect miracles. HDR toning converts the image into a 32 bit space and allows you to make some tonal adjustments. When you click Ok it goes back into its 16 or 8 bit space. It’s a cool looking filter that many people will enjoy when they only have a single exposure to work with. However I strongly recommend doing real HDR for the best results.

Have a look at this Single Image raw file pushed through HDR toning. Notice, the blown out areas in the doorway, they don’t gain detail, they just turn gray. The reason is that the detail wasn’t captured on the camera and therefore impossible to recover on any type of imaging.

PUPPET WARP TOOL

This is a great tool for people who are into Photo manipulation. This tool allows you to add anchor points to your image. You can then drag the points to warp the shape of the image. You can use the unselected points as anchor points. You can select multiple points by holding down the shift key.

This is a little akin to “rigging” a character for Inverse Kinematics, a 3D and animation term. The difference is that you can warp the image anyway you like. This is a lot better than the liquefy tool for these types of purposes. I can imagine that people are going to have a lot of fun with this tool!

To truly understand what it does; watch the free video I created on it.

LENS CORRECTION

The new lens Auto correction is really good. Photoshop contains a database of common cameras and lenses. It then looks at the metadata and makes adjustments to the curvature, aberration (color fringes) and vignette to automatically fix some of the most common lens issues. As you can see, it does an amazing job on removing vignetting. It also does a good job of geometric distortion. Although sometime you will prefer the distortion because we are so used to looking at it. Sometimes a photo looks odd without it. This all depends on the photo of course and many wide-angle photos look better corrected.

NEW BRUSHES

I’m not going to get too much into the brushes here because Jane and Wes have written plenty
about them. I also have a video for you to see them demonstrated.

In a nutshell, we now have natural bristles and new mixer brush that smudges the colors. You can paint from scratch or you can paint over a photo for a hand painted look.

OTHER CHANGES
There are a lot of other changes in Photoshop CS5. Let me touch on a few.

WORK SPACE SWITCHER
We have had the ability to choose and save different workspaces for some time now. In this release it has been brought to the forefront. There are now workspace buttons at the top of the screen. This controls panel layout, menus and menu highlighting as well as tool presets and menu highlighting.

JDI CHANGES
During the development process, Adobe told all the engineers to take time off what they were working on. During this time the focus was on working on “the little things”. Adobe looked at customer requests and made many little tweaks that have been requested. They called these JDI (Just Do it). Here are some of the JDI enhancements in CS5

- Delete Empty Layers Script
- Convert a 16bit file to 8bit without a dialog box on save to jpeg
- Neutral Density Gradient Preset
- Straighten image button added to ruler
- Turn off/on Gesture support
- Default for Shadow Highlight changed to 35%
- Can move a selection while Active layer is hidden. Doesn’t move the layer, just the selection.
- Option to always default to last saved folder
- You can drag and drop a file into an open PSD to create a layer
- Shift+Enter puts focus on the text fields on an adjustment layer. They also open with the focus on the text fields. This saves time because you can apply keyboard commands right away.

MINI BRIDGE
Have you even been working in Photoshop and you have the need to quickly grab an image. You don’t want to leave Photoshop for Bridge or even use an open menu. You know, when you’re in the zone and really focused. They have now added a small version of Bridge in a panel. It’s called Mini Bridge and it’s really useful in a jam or when you are working with lots of images. Personally I prefer Big Bridge because it’s faster. You also have to have Bridge running for Mini Bridge to display.

I do find Mini Bridge really useful for things like HDR, because I can merge them directly from Mini Bridge without the clutter of multiple photos on my desktop.

PASTE IN PLACE
Paste In Place has a few new options.

- Paste Inside has a few new options.
- Paste in Place, Paste Inside and Paste Outside. These little tweaks are bound to help you out a lot. I especially will use Paste In Place a lot.

CONCLUSION
I am more excited about this release of Photoshop than I have been for several upgrade cycles. I believe this is the biggest update we have seen for a while and there is something for everyone. Would I recommend upgrading? Tune in next week to find out. Just kidding! I recommend Photoshop CS5 without hesitation!

ABOUT THE AUTHOR
Colin Smith is a best-selling author, trainer, and award-winning new-media designer. He is founder of the world’s most popular Photoshop resource site, PhotoshopCAFE.com, which boasts over 20 million visitors. He is a regular columnist for Photoshop User magazine. He has been featured in most major imaging magazines including, Computer Arts, Macworld, After Capture, FSG Photoshop, Advanced Photoshop, Photoshop Creative, Digital Photographer, Web Designer magazine and a host of others.

Colin’s graphic design work has been recognized with numerous awards, including, MacWorld Digital Design and 3 Guru awards at Photoshop World 2001 and 2002, for his work in both Illustration and Web Design. He is also a coauthor of the popular Photoshop 7.0 Bible. Colin has consulted such companies as Adobe Systems, Edision International, Apple and Disney Studios.
Photoshop Can Paint! By: Jane Conner-ziser

Wow! CS5 came out smoking with new features and new ways of doing things! One of the most talked about features is the new Mixer Brush Tool. Nests within the Brush Tool in the vertical tool bar as the bottom option, it can be used with both the new Bristle Tip brushes and the standard Static Tip brushes. For the first time, Photoshop offers a means of blending colors beyond Smudging—whether you want to paint from scratch or combine paint with photography.

When you choose the Mixer Brush you will immediately notice new options available for it.

FROM LEFT TO RIGHT THE OPTIONS ARE:

- Tool Presets. There are some presets included that can be loaded by accessing more options from the upper right corner and selecting Mixer Brush Tool from the drop down menu, or you may prefer making your own once you become familiar with the way the brushes work.

- The third option is to hide and show the Brush Panel (or Palette).

THE NEXT THREE OPTIONS ARE BRAND NEW:

The color square shows the current brush load (red). If you choose to “clean” the brush from the drop down menu, the square will empty to let you know that there is no color currently on the brush and it will behave like a blender. This allows you to add color, then blend it without having to change brushes. In addition, the drop down from the color square provides the option to Load Solid Colors Only. If this option is on, when you sample color from an image (Opt or Alt tap), it will load a solid color based on the settings for the Eyedropper Tool. When Load Solid Colors Only is not selected, the sample from the image allows for loading the brush with multiple colors.

You can also choose to automatically reload a brush after every stroke or automatically clean the brush after every stroke by selecting from the two options just right of the current brush load icon.

CS5 even includes useful brush option combinations in the next drop down menu that helps jump-start you into painting. These choices were created using the options for Wet, Load, and Mix and are listed under the Custom option.

MAKE YOUR OWN COMBINATIONS BY ADJUSTING THESE OPTIONS YOURSELF:

- Wet = how “wet” the existing paint on the canvas is. A dry canvas will show a lot of the selected color being applied. A wet canvas will immediately begin blending existing color into your applied color. As the wet setting increases, the amount of paint picked up from the canvas while painting also increases. A Dry brush will not pick up paint while painting so no mixing is involved. A Wet setting with no color loaded on the brush allows blending of existing colors.

- Load = how much paint you have in the brush, or how long your color will last in a stroke. High loads last longer than low loads.

- Mix = how much the color on the canvas blends into the color being applied. Low mix settings pick up less paint from the canvas so more of the color being applied will show. High mix settings will not be as pure because the picked up paint will fully cover the brush.

- Flow = how fast the paint comes off the brush. Visually it looks like opacity. High flow gives a lot of paint at one time. Low flow layers it on more slowly.

The next option is to choose whether or not to use the airbrush option. This option gradually continues to build color as if you were using a traditional airbrush.

- Sample all layers allows you to create your painting on a New Layer instead of working directly on the background. Many artists who paint from photographs like to paint on layers so they can refer to the original image when needed. Artists who paint from scratch often like to work on layers so they can back up when they need to or make image adjustments to specific parts of the painting during the painting process.

- The last option is for letting the tablet pressure determine the size of the brush, overriding settings in the Brush Panel. This means that if you apply light pressure the brush is small. Harder pressure makes the brush larger. This settings override option is not available for the Bristle Tip Brushes.

The above new options are available for all brushes in Photoshop.

AND THERE’S MORE!

CS5 includes a new set of Bristle Tips that are capable of delivering a variety of stroke shapes and opacities that are user controlled with the direction and tilt of the Wacom pen. I’ve chosen the Round Tip Bristle brush to show you some of the new features.

As soon as you choose one of the new Bristle Tips a Preview of the brush tip and tilt becomes visible just to the top right of the vertical tool bar and under the tool options bar. This proxy can be used to visually learn how the brush responds to the tilt, rotation and pressure of the Wacom pen. It can also be turned off (upper right corner x) should you prefer not to see it. View / Show / Brush Preview will bring it back again.

I chose the Very Wet option from the drop down brush combinations and made two strokes, one using the tip of the pen and the other using the side. These brushes offer great variety of stroke and with a bit of practice allow you to paint with more control than is possible with static tip brushes.

The difference between using the standard brushes with the Mixer Brush and the new Bristle Tips is that the standard brushes apply paint more accurately for shaping objects and adding detail while the Bristle Tips offer more variety of stroke and better blending capabilities. This is because Static Tips use a single brush shape to generate the stroke while Bristle Tips are 3 dimensional models with individual bristles that bend and deform according to how you move, tilt and press the stroke
There is a new HUD Color Picker as well. Access it with Control+Option+Command (Mac) or Alt+Shift+Right Click (Win).

Brush Presets are no longer required to be size specific. They will take their size from the current brush setting.

Brush Resize and Hardness, brackets [ ] for size and { } for hardness can now be accessed with a single shortcut on screen. Control Opt (Mac) or Alt Right Click (Win).

AND there are new Color Picker options. Opt (Mac) Alt (Win) brings up a new Sample Ring that allows you to see the color you currently have compared to the color you are choosing prior to selecting the new color. You can choose to see or not see the Sample Ring by enabling or disabling this option located in the options bar for the Eyedropper Tool.

There is a new HUD Color Picker as well. Access it with Control+Option+Command (Mac) or Alt+Shift+Right Click (Win). This is a really fast way to choose colors that visually fit in with the project you are working on. You can set the size you want to see the HUD Color Picker in General Preferences.

There are a few other important notes and changes for painting in CS5.

When regular brushes are selected, there are new options added for controlling brush size and opacity using pressure without having to select them from within the Brush Panel.

If you choose to rotate the canvas, the brushes will retain their relative angle.

Brush Presets are no longer required to be size specific. They will take their size from the current brush setting.

Brush Resize and Hardness, brackets [ ] for size and { } for hardness can now be accessed with a single shortcut on screen. Control Opt (Mac) or Alt Right Click (Win).

AND there are new Color Picker options. Opt (Mac) Alt (Win) brings up a new Sample Ring that allows you to see the color you currently have compared to the color you are choosing prior to selecting the new color. You can choose to see or not see the Sample Ring by enabling or disabling this option located in the options bar for the Eyedropper Tool.

There is a new HUD Color Picker as well. Access it with Control+Option+Command (Mac) or Alt+Shift+Right Click (Win). This is a really fast way to choose colors that visually fit in with the project you are working on. You can set the size you want to see the HUD Color Picker in General Preferences.

IN ADDITION

CS5 is packaged with many new features and incredible new technologies. The new painting capabilities are just one of the exciting things you have to look forward to.

Be one of the first to upgrade and experience it for yourself!!

JANE CONNER-ZISER

Jane is an independent consultant and teacher for the professional photography industry. With 27 years of experience, 16 of them in digital imaging and evolving technologies, Jane’s projects have spanned across a large segment of the studio photography market - freelance art, photography, lab-systems, digital imaging, Internet, teaching Photoshop and Painter, fine arts, writing for industry publications and being part of development teams for marketing/selling software and strategies using new technologies. Jane has served on the Digital and Advanced Imaging Committee for the Professional Photographers of America. Considered to be one of the most talented and well rounded experts in the industry, her clients include Canons, Art Leather Manufacturing Co, Marathon Press, Kodak, many of the nation’s largest professional color labs, and numerous studios of fine portrait and commercial photography. Her engaging style, impressive knowledge of her field and her easy and entertaining way of presenting material make her one of the most significant educators in the industry today.

PHOTOSHOP CS5

PORTRET RETOUCHING SKIN TECHNIQUES

JANE CONNER-ZISER

3 HOURS, $79.99

How to make Faces look amazing...

This step by step project based DVD leads you through a variety of techniques to accomplish beautiful skin retouching. You will work on professional images by some of the world’s best portrait photographers, Clay Blackmore, Maz Mashru, Patrick Ciatto, Brooke Christl – and Jane – and learn how to sculpt faces, blend skin, remove shine, retouch wrinkles … everything pro retouching artists do on a daily basis. Taught by Jane Conner-ziser, an internationally respected retouching artist with over 25 years of professional excellence in the portrait industry.

PHOTOSHOP CS5

PORTRET RETOUCHING ADVANCED TECHNIQUES

JANE CONNER-ZISER

2 HOURS, 40 MINS, $79.99

Conquer the most difficult retouching challenges

These beyond the basics sessions include step by step hands on instruction on how to handle some of the most common retouching jobs in portraiture. The projects have been selected specifically to give you practice using a variety of techniques and the files are cropped to isolate the particular session topics. Included on the disc are a set of Jane’s Retouching brushes plus her layered psd files for your reference and visual guides in Photoshop.

http://www.photoshopcafe.com/video
Adobe has done it again - they’ve taken the foundational image processing engine of the world’s most popular raw converter and rewritten it from the ground up. The algorithms for this new “demosaicing” process allows Adobe Camera Raw 6 (like it’s cousin Lightroom 3) to achieve sharper, cleaner detail while also dramatically reducing noise in high ISO images. This quality boost would be worth the price of upgrade alone but the ACR team has also added new improved blending options for the Post-Crop Vignette feature and also the ability to add a simulated “grain” back into images to obtain a range of traditional film looks.

**REDUCED NOISE, CLEAN DETAIL**

How to get both has been the digital photographers’s balancing act for the last decade - especially if one didn’t want to rely on opening a file and applying pixel-based noise reduction/sharpening filter. ACR 6’s updated Detail panel gives you three new sliders to control Color Detail, and Luminance Detail and Contrast, but you may not need to play around much with these new options (though they do add indispensable control) because the ability to get accurate, saturated, yet non “Christmas Tree Lights” color, while maintaining smooth detail, is apparent even at the default settings of the new sliders.

With the results you’ll see you will be tempted to go back to some of your older portfolio files just to see what quality increase is possible. But there is a decision to be made: Adobe couldn’t just arbitrary go back to your already adjusted files (processed using the current 2003 engine) and update them to the new 2010 profiles. Well they could, but it wouldn’t be polite without asking, and that’s exactly what they do. Every time you open an image that was processed with ACR 5 or before, you’ll see a little exclamation mark in the lower right hand corner of ACR’s preview window telling you that new processing enhancements like Noise Reduction won’t be available to you unless you click on the icon and give ACR permission to use it’s new capabilities.

Of course, if for some reason you don’t like the changes (most of which are subtle and hard to see without zooming in on the file) you can always Undo and continue to work with the file as in the past. But as mentioned, if you DO click the icon, the file with gain a cleaner overall look (especially in shadow and highlight areas), and all the new Noise Reduction features will become available.

**STAYING SHARP**

The sliders in the Sharpening section of ACR 6’s Detail panel look and work exactly the same as in ACR 5 (and if you’re not familiar with the subtleties of the Radius, Detail and Masking options, you should be - they offer incredible control over where and how sharpening is - and is NOT - applied), but they now take advantage if the new processing engine to achieve even greater detail with less potential edge artifacts.

**BUT I WANT TO ADD NOISE!**

Actually, when we add noise back into an image (using something like Photoshop’s Add Noise filter) what we are usually trying to imitate is the organic “patina,” the texture, the finger print, of certain film grains of yesteryear. Film grain is visually very different from digital camera noise, with its inherent randomness, “clumpyness” and size variations caused by the small grains of metallic silver halide...
ACR 6 to the rescue! With two new Priority "blend modes" (Highlight or Color Priority) and an additional Highlights protection slider, it is much easier to get subtitles like skies to “burn” gracefully, while maintaining the crisp highlights of the subject matter that extends into the edge area. And if you want a framing effect, the Paint Overlay option is still there (and very useful at a low Roundness and Feather setting)

AND DON’T FORGET THE GAME-CHANGER THAT CAME IN WITH ACR 5!

Yes, you combine these incredibly useful (I’d say completely indispensable!) improvements in ACR 6, with the paradigm shift that came in with the targeted adjustment tools in ACR 5 (not to mention it’s incremental updates that brought us lifesavers like the Targeted Adjustment Tool and the Snapshots panel!) and you have a complete procedural, non-destructive, quick and easy, one-stop shop for 90% of your photographic post processing needs! Quality, Flexibility and Speed - Thank you Adobe for ACR!!!

Jack Davis
Jack is co-author of the award-winning and best-selling guide to Photoshop, “The Photoshop Wow! Book,” as well as an award winning designer / illustrator / photographer and contributing editor to numerous other books on digital imagery, design, and on-line communication. He is an internationally recognized expert on digital imagery and the visual communication process. He has lectured at conferences and universities throughout the US, Japan, Singapore, Hong Kong, Canada, Brazil and Australia, as well as leading numerous workshops around the US and abroad. He teaches as part of the “Dream Team” at the National Association of Photoshop Professionals’ Photoshop World Conferences. Jack was recently inducted into the NAPP Photoshop Hall of Fame. Jack has recorded several DVDs for Software-Cinema.com.

VIGNETTES DONE RIGHT

Originally added to the Lens Corrections panel in ACR to help get rid of the inconsistent darkening tone at the edge of wide angle shots, vignetting has become a tool (some would say an overused tool) in the photographers Bat Utility Belt to intentionally darken the edges of an image to help draw the viewers eye into the subject of the photograph.

The problem was that since it was designed to fix an issue with the full frame of the shot as it was captured, when a composition was cropped, the edge effect didn’t “rewrap” to follow the new size. Hence ACR 5’s Post Crop Vignette option that would follow along with the new image size. The only problem was that while the original Vignette feature has a beautiful dodge and burn result that lightened or darkened the original colors of the photograph, while maintaining the integrity of the highlights of the scene, the ACR 5 Post Crop Vignette was just a layer of blurry white or black “paint overlay.” This was great if you wanted an opaque frame effect (with muddy grey highlights), but poor for the intended aesthetics associated with a quick dodging and burning of edges.
Photoshop CS5 – What’s in it for tablet users? By Weston Maggio

A lot will be written about Adobe Creative Suite 5 and all its goodness for months to come. As it should be, seeing as CS5 represents one of the biggest updates to the Creative Suite since it has been bundled as a suite! But beyond all the marketing-speak, with each new release of the Creative Suite, what I really want to know is, “What’s in it for tablet users?” And I’m happy to say, “A whole lot!”

Photoshop CS5 is pen-centric through and through. We see this first hand with a new tool, The Mixer Brush. This brush emulates the effects of a traditional artist’s brush whose tip was dipped in multiple colors and then blended together. This blending of colors can be applied to a blank canvas to achieve the look and feel of various traditional media. Alternatively, you can use the Mixer Brush on a photo, picking up the underlying colors as if they were wet media, adding an artistic or painterly effect to any image.

This tool offers an extensive set of controls to alter the effects of the brush. For example, you can determine the wetness of the brush, how much paint is held on the tip, how much of that paint mixes between the tip and the canvas, and how clean the brush is after each stroke. Every characteristic that you would expect from a traditional paintbrush.

And speaking of traditional brushes, you are going to love new Bristle tips. Once you’ve selected a brush tool, you need to choose a brush tip (in the Brush panel, which I’ll get to in a moment). New Bristle tips offer stroke characteristics that rival traditional artist’s brushes. Brushes with a round, blunt tip or a flat fan brush for example. Beyond the shape of the brush, every aspect of a brush’s behavior can be modified to give you the most natural effects imaginable. Including the length of it’s bristles, their thickness, stiffness and angle of the brush tip. All of these characteristics affect the way in which color is applied on the image.

You can use one of the ten standard Bristle tip presets, or create and save your own to match your preferred look or style.

Assisting you in the creation and use of your new Bristle tip brushes is a Bristle Brush Preview feature which provides you with a real-time reference of the brushes look and behavior. This floating window gives you a visual representation of your brush when selected and active. This preview window is not only effective in the creation of new brushes, but also flat out fun!

These new painting tools and features are exciting stuff for literally every type of Wacom tablet and Photoshop user. Whether you are a photographer seeking the addition of artistic enhancements to your images, or an illustrator/artist wishing to extend their creative vision, or a designer who makes dynamic composites and effects. These new painting tools and functions are going to change the way you work!

New is cool, but with CS5 newly redesigned is
cool tool! Savvy tablet users will immediately notice that the Brush panel icon found on the right-hand of the options bar has moved to the left to join some other brush related options. Clicking this icon opens the Brush panel, where you’ll find the majority of your dynamic (pressure) controls. The icon itself has changed as well. Formerly a dog-eared page full of bullet points, it now appears as a folder with a little jar of artist’s brushes on it.

Inside the Brush panel things look fairly similar to previous versions. A closer look will reveal that a button labeled Brush Presets has been added. Brush presets have been broken out into their own panel in CS5, and for good reason. With the inclusion of new Bristle tips—and a new way of thinking about brushes altogether—makes this a good move in my opinion. In the past, numerous size brush presets with similar attributes clogged up the Brush panel, where you’ll find the majority of other brush related options. Clicking this icon opens the Brush panel, where you’ll find the majority of your dynamic (pressure) controls. The icon itself has changed as well. Formerly a dog-eared page full of bullet points, it now appears as a folder with a little jar of artist’s brushes on it.

Back on the Options bar, you’ll notice that two new icons appear when you select any tool that behaves like a brush. (There are 17 brush-like tools in Photoshop CS5). These tablet pressure icons (which resemble targets with a pen in them) enable pen pressure control of opacity and size of the brush tip. The controls govern the use of pressure, overriding any settings that may have been applied to the current brush.

This is a welcome return of a feature as it brings back an option to quickly turn pressure on and off for the two most popular controls—a feature not seen in Photoshop since version 7. Remaining visible, always on the Options bar, these controls are more accessible and more discoverable. This is refreshing for new tablet users, or those not very comfortable in the Brush panel. The tablet pressure icons toggle control on and off with the quick tap of your pen!

While Photoshop’s new painting tools and effects are redefining your creativity, here are a couple of new or improved tools that really shine when used with a tablet.

Topping my list of favorite new tools is actually an “old” but enhanced tool: The Spot Healing Brush. It takes advantage of CS5’s new Content-Aware feature, which delivers almost magical results! When painting over unwanted elements in an image, the structure and details around the area are preserved and smoothly blended in its place. In most cases, it is as if the element never existed! You can really power through an image when applying this tool with your pressure-sensitive pen!

While I prefer to do my sharpening at the very end of my workflow, and in most cases just before printing, I can’t help but appreciate the Sharpener tools new Protect Detail feature. This option frankly makes the tool actually usable in that it doesn’t immediately throw pixels into an oversaturated halo spin-cycle! Controlling its strength with pen pressure, and a gentle hand, it’s a nice tool to have in your toolbox for down and dirty enhancements to eyes, jewelry, and otherwise sparkly things. It won’t replace Nik Sharpener Pro by any means, but for that quick glimmer of light, it’s a cool tool.

Making selections is a big part of every creative workflow, and there is no better and faster way to make selections than with the natural precision of a Wacom pen. CS5 offers new intelligent edge detection technology to give users an unprecedented level of control in the making of selections and masks. This is especially ideal when working with complex subjects like hair, and semi-transparent material. Once you’ve made an initial selection, use the slider controls in the Refine Edge dialog to tweak it. Then, finish it up with the Refine Edge Radius brush. This tool enables you to fine tune the edges of your selection by carefully painting the line around the selected subject. The action results in an expansion or contraction of the selection around the original edge. Ideal in situations where you wish to extract an element from a photo—free from residual background colors or contaminates—and place it on another background. This pressure-sensitive tool is a hidden gem, but very useful.

I can easily say that there are few—if any—images that I work on that don’t incorporate the use of some type of adjustment layer. Whether it is levels or curves for a tonal adjustment, or vibrance or hue/sat for some color, I’ve just got to have them! I’m addicted to them. There, I said it. When I learned of the new HDR Toning adjustment, I was intrigued with the effects that it can produce. Combinations of this new adjustment will most certainly find its way into my images.

Tip: The HDR Toning adjustment requires that you flatten your image. In early uses of this adjustment,
I’ve created a duplicate image, applied the adjustment, then drag and dropped the adjusted image back into my working document, where I can add a layer mask for compositing. (Hold the Shift key while drag and dropping the adjusted image back in the open doc to place it in perfect register.)

Wow! That’s a brain dump on a lot of new features, and at the same time not much at all, huh. Like I said, there is a ton of new features in CS5. Especially for tablet users! If you are not already using a Wacom pen tablet, there has never been a better time than with Photoshop CS5! For tips on setting up your Intuos4 pen tablet or Cintiq interactive pen display and using it in Photoshop CS5, check out the new title from PhotoshopCAFE: “Wacom Tablets and Photoshop CS5”. All new content.

Photoshop Secrets
Wacom Tablets and Photoshop CS5
COLIN SMITH + WESTON MAGGIO
3 HOURS $39.99

This is the 5th edition of THE best-selling video on Wacom tablets and Photoshop. The most complete training on the Wacom Tablet and Adobe Photoshop ever! This fully updated video will show you how to unleash the power and creativity that only comes from a pressure-sensitive tablet. Set up your tablet correctly and stop working like a mouse user in Photoshop. Two of the Top instructors in the industry combine their talents to bring you a video that will totally change the way you approach graphics on your computer.

If you currently own, or are considering a pen tablet or Cintiq™, this video is one of the best investments you can make:

http://www.photoshopcafe.com/video

Beauty is finally easy. Beauty Box Photo lets you:
• Quickly and easily erase skin blemishes
• Even out skin tones and smooth wrinkles
• Keep important details like eyelashes, teeth and hair razor-sharp, while just smoothing out the skin.
• Use batch processing to effect groups of images.
• Fast processing using GPUs and nVidia’s CUDA.
• Get a consistently professional, natural result — automatically!

Whether it’s used for a glamour shoot, senior portraits or a personal photo, Beauty Box Photo makes your client look her best.

Regular price: $99.00
Exclusive price discount for Photoshop Cafe members at:

http://digitalanarchy.com/beautyPS/pscafe.html

Beauty Box Photo works in Photoshop CS-CS5 & Elements, Macintosh & Windows, and is 64-bit compatible.

Shooting Video With Your DSLR?
Then check out our sister product, Beauty Box Video, for smoothing skin in video within Final Cut Pro or Premiere Pro.
When 3D integration was first introduced in CS3, most artists were very skeptical due to its elementary ability to utilize 3D objects in general. When CS4 improved upon the 3D engine, then artists began to see the potential and realized that Adobe was on to something. As a result, that has created a demand from concept artists who found value in taking the 3D objects from their coworker, to use in their final concept art. Now Adobe has made vast improvements to the 3D engine that I think will get you thinking in the direction of utilizing 3D in both your concept and fine art imagery.

We are going to explore the 3D tools in CS5 Extended through a new addition in Photoshop called Repousse. Repousse, in my opinion, is Adobe’s first step into a custom 3D modeling engine where you can create your own 3D objects. Currently, it’s limited to creating 3D logos and simple shapes however I anticipate that it will become more sophisticated in the next builds to come. Let’s have fun.

STEP 1
Create a simple text (T) in a document of 3.5 X 7 inches. Use a font that is fairly wide and bold. In this example I used Eras Bold ITC on a text titled “3D Rocks!!”.

STEP 2
If the text is black by default, change the color to anything that is lighter. Also, resize your text (Ctrl-T/Cmd-T) so that it will stand tall and prominent in the document and shown in figure 2.

STEP 3
Now apply Repousse(3D>Repousse>Text Layer)

STEP 4
When you get a message stating that the text will be rasterized; click “Yes” and let’s continue. Automatically, you will get an extruded text 3D object as shown in figure 3. As you might have already anticipated this will be a great tool for 3D logos.

STEP 5
Apply texture to the face and bevel edge

STEP 6
In Repousse, you are given presets for every surface of the 3D object. Play with these to discover what affect they will have on your object. In this example, the inner bevel preset is selected for the surface of the object and its parameters are adjusted as shown in figure 4.

STEP 7
On the top right, apply a texture preset to the face and bevel edge of the text.

STEP 8
Now apply a different texture to the bevel of the text. I used a bluish texture to differentiate from the face.

STEP 9
Now apply a different texture to the sides of the text. I used a reddish texture that utilizes the Transparency map to place holes into the surface of the sides. This will work for more of an industrial look.

STEP 10
Experiment with the shear capabilities, and shear upward on the “Y” axis so that the extruded object bows upward as you can see in figure 8.

STEP 11
Next, apply some presets for lighting. We will change them a little later, but for now experiment. Choose one and click “Ok”. Play around with the object using our 3D navigational tools.

STEP 12
Apply custom lights to text

Take a look the new 3D layer and 3D Scene Panel (Window>3D). Notice that all of the textures that were
Now we will place the 3D text onto a sunset lit scene.

The text will sit above another 3D object created from a photographic image. We will then add some Image Based Lighting (IBL) to light the entire scene.

**STEP 1**
Place the "mud" texture image into a layer below "3D Rocks!!!". Make this into a Smart Object. Duplicate the layer for insurance.

11. Click the "Show All" option to view all 3D visual guides.
You will also see that the various 3D elements have color coding. This can be changed in the 3D Preference panel (Ctrl-K/Cmd-K). Figure 12 shows changes to the light, mesh and material color.

**STEP 2**
Alter the mud layer into a 3D Postcard (3D>3D Postcard) so that you can now navigate it in 3D space.

**STEP 3**
We are going to add an effect to the text where the back end of the extrusion will become transparent. In the layers palette, find the Opacity texture layer titled "Fun-mask-Materila-A2b" to access the texture that creates the holes in the walls of the text.

If you notice, the areas that are transparent are the places where the dark holes are located. Transparency maps work from B&W information. Black will make an image completely transparent and white will maintain the opacity of the 3D object. Apply a gradient where the top portion is transparent and the bottom is completely black. This will keep the front half untouched and graduate the rear toward 100% transparency.

**STEP 4**
You will now access each of the 3D objects independently through the 3D Mesh panel (Window>3D). Use the 3D Mesh navigational tools to position the text as you had it previously.

Now it’s time to add the Image Based Lighting (IBL) to get the 3D object to match the scene’s visual light quality.

Fig 22. Results of Reedit 3D object in Repousse
IBL lighting is simply a technique where the 3D light will use the colors and luminance of your chosen image to light the scene. Normally, we would use an image that is a seamless 360 degree panorama to light and reflect into any reflective areas on the 3D object. Since we do not have a large area with reflective properties on the object, we will use a merged file that consists of the sky and the cracked mud.

It’s important to understand that you can use any standard photographic image to light the scene. Also, keep in mind that the IBL lighting feature can use 32 bit or HDR images. To keep the file size down for tutorial purposes, we will use the 8 bit jpeg format. On your own, try using the new HDR Pro and save the results of the merge as a luminance file (.hdr) and use that for your IBL image to discover the difference. Temporarily turn off the 3D text using the 3D Mesh Panel (fig. 23) and save the file as a jpeg under another name like “Sunset.jpg”.

STEP 5
Import the sunset.jpg into the IBL light source. Make sure that the “Cast Shadows” check box is activated so that we get realistic shadow results on the 3D text. Figure 24 shows the results of object being lit with the sunset image.

STEP 6
You will see the sunset image wrapped around your IBL globe to represent that the entire scene is lit evenly from all around it in a 360 degree sphere. If you rotate it, the object will display the sunset image wrapped around it and light the scene according to where a particular color or luminance is positioned. For example, if the orange glow of the sunset is in the foreground, and the top portion has the bluish glow, then the foreground of the 3D object will receive the orange cast and the top of the object will have a bluish cast.

Now, quickly add a spotlight to the scene to light the text from behind and give the light a yellowish color. This gives the look of directional lighting coming from the sun behind.

STEP 7
Finally, let’s add depth of field (DOF) by activating the 3D Zoom Camera tool and some texture that will give the logo more interest. Let’s begin with the texturing.

Look at the 3D Materials panel and select the “3D Rocks!!! Extrusion Material” texture. Next to the Diffuse category, activate the drop menu and select “Open Texture”. You will see the layers that are used to create the current texture. Use “metal.jpeg” and place it in a layer on top of the current layers and resize it to get the texture of your choice. Experiment with this and use your own textures as well.

Now, let’s apply the Depth of Field. On the options panel, the “DOF Blur” sets the amount of the blur that actually resembles Gaussian blur. The “Distance” determines where the blur begins. You can use a shortcut to set where the DOF will begin is by holding down the Alt/Opt key and clicking on the location that you want the blur to begin. In this example however we are looking straight on to the text so it becomes difficult for Photoshop to determine what depth you are interested in, as a result, use the Distance slider.
This latest release of Flash has a number of great features, for pretty much everyone. In this article we will take a first look at this list of features so you can get up to speed on what’s new and what’s changed.

**TEXT LAYOUT FRAMEWORK TEXT ENGINE**

The newly introduced TLF text engine provides improved control over text properties and flow. You can now define how text should display within your applications with ease. For instance, you can now create a two/three column layout without having to separate your text content. The text will even expand/contract as you change the various parameters within TLF.

**VIDEO CUE POINTS**

Video cue points in Flash CS5 are now easier to add to videos. If you had worked with cue points in previous versions, this update will help you immensely. Adobe has now made it easy to add, remove and manage your video cue points with ease.

**PACKAGER FOR iPHONE**

A groundbreaking feature found in Flash CS5 is the ability to develop iPhone apps using ActionScript. This gives Flash developers an opportunity to expand their user base to the mobile platform while still maintaining other Flash versions of their application.

**XFL FILE FORMAT**

Another great addition to Flash CS5 is the new file format, XFL. This custom file format is mostly a “behind the scenes” feature. However it makes it possible to work with other Adobe applications, allowing others to make changes and exchange content without the complications found in previous versions.

The XFL file format also gives you the ability to work in an uncompressed format. This gives you the ability to work in team environments and even with source control (such as SVN). You can now expand the Flash file and edit individual assets with the changes being reflected the next time the Flash document is opened.

**FXG FILE FORMAT**

Similar to the XFL file format, the FXG format gives creative’s the ability to exchange graphics in Flash with other Adobe graphics applications. This only strengthens the collaboration concept that Adobe is well known for throughout the entire Creative Suite. It will be interesting to see how designers, developers, and studios utilize these new file formats to the best of their ability.

**ACTIONSCRIPT EDITOR IMPROVEMENTS**

If the AS editor found in Flash has ever bothered you then you will be happy here too. Flash CS5 introduces a number of fixes and advancements for the forgotten editor. Some of these updates include code hinting for custom classes, self closing brackets and auto importing of custom classes, to name a few.

However, another amazing update is the ability to use Flash Builder as your editor while seamlessly working with Flash. For example, if you edit a class in Flash with Flash Builder selected, the class will open in Flash Builder, then when you test your changes Flash will regain focus. Once you leave the test, Flash Builder will gain focus allowing you to quickly make changes. This workflow is especially useful to those developers that used Flex Builder in previous versions.

Note: A new panel has been added for non-developers, the code Snippets panel allows can be used to apply ActionScript 3 code for common interactions without learning complex code.

In fact there are already many apps in the App Store that have been built with Flash CS5. One of those applications is featured in my article on the Packager for iPhone, which is in this guide.
Another online tool found in Flash CS5 is CS Live services. These allow you to connect to Adobe tools from within the Flash authoring environment. CS Live includes web services such as Acrobat.com, BrowserLab, Live Review, and more.

CLOSED THOUGHTS

There are two new features found in Flash CS5. As you can tell, Flash CS5 is a major advancement over previous versions of Flash. Now take the time to explore all of the new features and content on your own. As always, post a comment on the forum and be on the lookout for great video training from PhotoshopCAFE on Flash and other Creative Suite applications soon.

BONUS FEATURE

One of the “more simple” features found in Flash CS5 is the SWF Size History which is found in the Document Property Inspector. This displays the size of all SWF files that are generated during “Test Movie”. This can be used to see how your SWF is growing as you change content. The SWF History will warn you with a yellow icon when the SWF size doubles.

PACKAGER FOR IPHONE: GETTING STARTED

You will notice many new features and additions in Flash CS5, but the one that stands out is the Packager for iPhone. Adobe has now given Actionscript developers the ability to create applications that can be sold and downloaded on the iTunes App Store without ever having to learn Objective-C. All you need is a copy of Flash CS5, prior Actionscript knowledge and an iPhone Developer account.

This article will get you started using Flash CS5 to create iPhone applications on Mac and PC. Included with this article is the complete source code for Happy Peg, an application already available on the App Store.

Note: While an iPhone Developer account is required to run, build and debug your applications on the iPhone, you can use the simulator included in Flash CS5 to test most of the features and functionality.

Before diving into the development process, make sure you have signed up for an iPhone Developer Account and everything has been verified and approved. Also, make sure you have iTunes installed on the machine you intend to use in order to install your iPhone applications once you build them. Finally, ensure you have downloaded and installed all of the necessary certificates and provisioning profiles in order to build and install your iPhone applications.

To download the complete source code for Happy Peg, an application already available on the iTunes App Store, visit "http://scriptplayground.com/iphone"

BUILDING THE HELLO WORLD APP USING FLASH CS5

Once you have created and downloaded the necessary files you are ready to build your first iPhone application. Following the standard development process let’s build the popular Hello World app.

Open Flash CS5.

Select “File > New” in the dialog, as shown in figure 1 and choose “iPhone OS.”

Click OK to open a new Flash document. Once the Flash document is opened follow these steps.

1. Select the Text Tool (T) and create a text field on the stage.
2. Once the Flash document is opened follow these steps.
3. Click OK to open a new Flash document.

With the newly created text field still selected open the Properties Panel and ensure “Classic Text” is chosen. Then, open the Paragraph tab and ensure “Left Align” is selected.

You will notice many new features and additions in Flash CS5, but the one that stands out is the Packager for iPhone. Adobe has now given Actionscript developers the ability to create applications that can be sold and downloaded on the iTunes App Store without ever having to learn Objective-C. All you need is a copy of Flash CS5, prior Actionscript knowledge and an iPhone Developer account.

This article will get you started using Flash CS5 to create iPhone applications on Mac and PC. Included with this article is the complete source code for Happy Peg, an application already available on the App Store.

Note: While an iPhone Developer account is required to run, build and debug your applications on the iPhone, you can use the simulator included in Flash CS5 to test most of the features and functionality.

Before diving into the development process, make sure you have signed up for an iPhone Developer Account and everything has been verified and approved. Also, make sure you have iTunes installed on the machine you intend to use in order to install your iPhone applications once you build them. Finally, ensure you have downloaded and installed all of the necessary certificates and provisioning profiles in order to build and install your iPhone applications.

If you have not completed this process you can use the step-by-step guide over at the Scriptplayground iPhone Learning Center.

http://scriptplayground.com/iphone

Click OK to open a new Flash document. Once the Flash document is opened follow these steps.

Select the Text Tool (T) and create a text field on the stage.

Click once in the text field and type “Hello World”.

With the newly created text field still selected open the Properties Panel and ensure “Classic Text” is chosen. Then, open the Paragraph tab and ensure “Left Align” is selected.
Save the file and Test the application “Control > Test Movie > In AIR Debug Launcher” or using the keyboard shortcut Cmd/Ctrl + ENTER. You should now see a preview of your “Hello World!” application running.

Congratulations, you have successfully configured and tested your first iPhone application using Flash CS5. Now let’s build on this and test the app on your very own iPhone.

**COMPILING, INSTALLING AND TESTING THE HELLO WORLD APP**

Note: Make sure you have installed the Provisioning Profile on your iPhone in order to install and run your app. You will not be able to install your own custom apps without the Provisioning Profile installed.

**COMPILING THE APP**

Start by opening the iPhone Publish Settings and filling in the following settings. Once all of the fields are completed click “Publish” to create the iPhone App file. This process may take a few moments but once you see an .ipa file appear in the directory you exported to, the process is completed.

**INSTALLING THE APP**

The process of installing an app on your iPhone is accomplished by double-clicking on the .ipa file. This will launch iTunes and install the app in iTunes. Once your iPhone is connected to your computer, start the sync process and the app will be installed on your iPhone. If you see any error messages, the most common cause is due to an incorrect Provisioning Profile or Certificate not properly installed. Verify these steps once again and try again.

**TESTING THE APP ON THE IPHONE**

Once your iPhone is synced, the Hello World application should be installed. Simply click the app icon and you should see the text “Hello World!” on your screen, as shown in figure 3 below.

You have now successfully created, installed and run your first iPhone application and all using Flash CS5. Pretty cool huh? Well, it only gets better. Let’s now look at a real world application that is available on the App Store right now.

**“BEHIND THE SCENES” OF HAPPY PEG**

I am sure you are familiar with the “Peg Game,” many have seen and even played it in various restaurants, bars and other public establishments. Well that original game was recreated using Flash CS5 and deployed on the iPhone. Happy Peg was born all within a weekend and is a true testament to the rapid development potential the Packager for iPhone offers existing Actionscript developers.

In fact the app could have been developed even faster due to the fact it was created while this great new technology was still being completed, so a few hurdles were encountered along the way. The good news is those have now been worked out and its smooth sailing for Actionscript developers.

“Hello World” application can be installed. Simply click the app icon and you should see the text “Hello World!” on your screen, as shown in figure 3 below.

**DEVELOPING THE APP**

The process of actually developing the app was accomplished by using standard Actionscript 3 class and code concepts. Each screen was made into a Movieclip instance and only initialized when visible. This was done to cut down on memory consumption, as the iPhone does not have the same memory a desktop Flash app would.

When working with animations you want to limit the amount of filters and effects (such as Alpha) because the rendering speed and overall performance of the iPhone or any phone is cut down when processing these portions.

There are no “rules” when preparing art for the iPhone apps but because it is a mobile platform you want to take file size and rendering speed into consideration. Most of the time you will find a JPG or PNG will do the job and whenever possible do not use alpha transparency as it does cause a rendering slowdown in your apps.

For Happy Peg a PSD was developed of the screens by importing the graphics from Illustrator. The artist chose to build the entire User Interface in scalable vector so the app could be resized. This becomes especially important if you intend to build larger screen apps, such as for the newly released iPad.

Once the assets were created, they were exported as flat image files and put together inside Flash CS5. Some of the assets, such as type, were recreated in Flash to ensure they stayed crisp and clear.

Note: Fonts must be embedded, which does enlarge file size. It is important to decide if you need actual fonts or could use graphics.

**DEPLOYING THE APP**

The process of actually deploying the app was accomplished by using standard Actionscript 3 class and code concepts. Each screen was made into a Movieclip instance and only initialized when visible. This was done to cut down on memory consumption, as the iPhone does not have the same memory a desktop Flash app would.

When working with animations you want to limit the amount of filters and effects (such as Alpha) because the rendering speed and overall performance of the iPhone or any phone is cut down when processing these portions.

While developing, you are sure to run into issues in your code so the ability to debug has been added. You can connect to your iPhone and remotely debug or run your app on your computer in ADL. However, it is important to know when debugging any remote profilers or tools it will cut down on performance so debugging and benchmarking should not be attempted at the same time.

**PUBLISHING THE APP**

Once the app was written and tested, it was time to publish to the App Store. In order to do this you must download Deployment provisioning profiles, rebuild your app using the Deployment options in AIR Settings and finally upload the .ipa file to iTunes. Once Apple looks at and approves your iPhone app you will be able to tell the world about it. If your app is not approved, you would need to repeat this process with necessary fixes made each time to re-submit for review.

**CLOSING THOUGHTS**

There you have it, a way to use your Actionscript experience in building your very own iPhone apps. It is important to note there are a few limitations, but you will find most AS3 APIs are available and most iPhone functionalities. There are some exceptions with the initial release such as Camera/Microphone and In-App Purchasing. However, Adobe has assured developers they are committed to updating the Packager for iPhone moving forward and will be adding additional APIs as time goes on.

For now, get ready to build awesome iPhone apps and realize your Actionscript skill has just gained an additional advantage.

Be on the lookout for more looks at the iPhone app development process on PhotoshopCafe.com and Scriptplayground.com. As well as video training brought to you exclusively by PhotoshopCafe.
Adobe has yet again done a great job of upgrading Illustrator CS5 with powerful and sophisticated drawing tools, life like brushes and numerous time saving commands and tools. Below is a list of features now available in Illustrator CS5.

- Variable Width Strokes
- Dashed Line Adjustments
- Precise Arrowheads
- Stretch Control for Brushes
- Brushes with Corner Control
- Perspective Grid
- Bristle Brush
- Crisp Graphics for Web and Mobile Devices
- Multiple Artboards Enhanced
- Shape Builder Tool
- Symbol Enhancement
- Artboard Ruler Origin and Coordinates
- Path Join
- Select Behind
- Draw Behind and Inside
- Roundtrip Editing with Adobe Flash Catalyst CS5
- Resolution Independent Effects
- Pixel Grid Alignment
- Enhancements of the Gradient Mesh

Let’s go ahead and take a look ... 

VARIABLE-WIDTH STROKES

There are a number of new features that have been introduced to Adobe Illustrator CS5 that make designing with strokes even more powerful, flexible and easier to use than ever before. You can control stroke width, dashes, arrowheads, and stretch brushes along a path.

The Width tool is available in the Tools panel. Use the Width tool to draw strokes with variable widths that can quickly and smoothly adjust at any point, symmetrically or along either side. You can also create and save custom width profiles, which can apply to any stroke.

DASHED LINE ADJUSTMENTS

New options in the Stroke panel now allow you to control the alignment of dashes. You can choose to align dashed strokes symmetrically around corners and at the end of open paths or preserve the dash and gaps in strokes. Choose between adjusted and preserved dashes and gaps.

PRECISE ARROWHEADS

You can now select and define arrowheads using the Stroke panel. Resize the tip and end of the arrowheads independently by using the Scale option. Also you can choose to lock the tip or base of the arrowhead to the path endpoint.

STRETCH CONTROL FOR BRUSHES

Scaling for art and pattern brushes along a path. Choose areas of the brush graphic to be stretched and those that need to be kept in proportion.

Example: To extend the middle of a banner graphic while keeping the detailed curly ends of the banner from stretching.

BRUSHES WITH CORNER CONTROL

Apply art and pattern brushes to a path and get clean results at tight bends or corners. Where strokes of different widths join, or they form acute angles, choose options to correctly fill points where joins occur.

PERSPECTIVE GRID

The new Perspective Grid tool allows you to turn...
on a grid that supports drawing directly on planes of true perspective. The perspective grid allows you to draw shapes and scenes in accurate 1, 2, or 3-point perspectives. The new Perspective Selection tool allows objects to be moved, scaled, duplicated, and transformed dynamically in perspective. You can also move objects perpendicular to its current location using the Perspective Selection tool.

With Perspective Grid tool group; work quickly and easily in a preset perspective.

Use Perspective Grid to draw and add vector objects to a reference photograph or video placed on your Artboard.

Example: easily add a number of street lamps, or fence posts to a landscape scene.

THE FOLLOWING FEATURES IN ILLUSTRATOR FACILITATE DRAWING IN PERSPECTIVE:

- Control different perspective defining parameters interactively.
- Utilities to define or edit 1, 2, or 3 vanishing point perspectives in a document.
- Create objects directly in perspective.
- Bring existing objects in perspective.
- Move or duplicate objects toward a perpendicular movement.

grid for pixel-aligned artwork. Standard web graphics at 72ppi resolution need to look sharp, this is critical when designing artwork for Adobe Flash Catalyst, Adobe Flash Professional software, and Adobe Dreamweaver. Pixel alignment is also useful for video resolution rasterization control. In Adobe Illustrator CS5, new web graphics tools include type enhancements. Choose one of four text anti-aliasing options for each of your Illustrator text frames. Choose among Sharp, Crisp, Strong, and Smooth, which match the text anti-aliasing in Adobe Photoshop®.

MULTIPLE ARTBOARDS ENHANCEMENTS

Work on up to 100 Artboards of various sizes, organize and view your way all in one document. The new features include a new Artboards panel, which allows you to create new Artboards, reorder Artboards in the Artboards panel, rearrange Artboards, and create duplicate Artboards. Specify custom names for your Artboards using the Control panel and the Artboards panel. You can paste objects at a particular location on the Artboard and paste artwork on all Artboards at the same location using the new Paste in Place and Paste on All Artboards options. You can also set the option to automatically rotate Artboards for printing.

SHAVE BUILDER TOOL

The Shape Builder tool is an interactive tool for creating complex shapes by merging and erasing simpler shapes. It works on simple and compound paths, intuitively highlights edges and regions of the selected art, which can be merged to form new shapes. Draw a stroke across the middle of a circle and quickly create two half-circles without opening any panel or choosing another tool. The Shape Builder tool can break overlapping shapes to create distinct objects and easily adopts art styles when objects are merged. Also, enable the Color Swatch cursor to select colors for your artwork.

Criss Graphics for Web and Mobile Devices

Create vector objects precisely on the pixel grid for pixel-aligned artwork. Standard web graphics at 72ppi resolution need to look sharp, this is critical when designing artwork for Adobe Flash Catalyst, Adobe Flash Professional software, and Adobe Dreamweaver. Pixel alignment is also useful for video resolution rasterization control. In Adobe Illustrator CS5, new web graphics tools include type enhancements. Choose one of four text anti-aliasing options for each of your Illustrator text frames. Choose among Sharp, Crisp, Strong, and Smooth, which match the text anti-aliasing in Adobe Photoshop®.

Figure 09 – Bristle Brush Options.

Figure 08 – Perspective Grid.

Figure 10 – Text anti–aliasing options.

Figure 12 – Rearrange Artboards options.

Figure 11 – Multiple Artboards.
Artboard ruler origin and coordinates are now oriented from the upper left. Scripts that use a previous coordinate system also work correctly with this enhancement. You can also choose to work with a global ruler (document ruler) that provides coordinates across all your Artboards, or work with local, Artboard-specific rulers.

Figure 15 – Rulers.

Path Join
Join open paths in a single keystroke with the objects selected. You can choose to join open paths using corner joins or smooth joins. You just need two or more open paths selected and apply Ctrl / Cmd + J or Object > Path > Join to have the selected paths join into one open path. More than two paths can be joined together in one go.

Figure 16 – Path Join.

Select Behind
Use a keyboard shortcut to easily select an individual object located behind other objects. In Adobe Illustrator CS5, you can select objects that lie underneath other objects using Ctrl / Cmd + Click.

Draw Behind
The Draw Behind mode allows you to draw behind all artwork on a selected layer.

The artwork needs to be selected first for the new object to be drawn directly beneath the selected object.

Draw Inside
The Draw Inside mode allows you to draw inside the selected object.

Draw inside mode is enabled only when there is a single selected object (e.g. path, compound path, or type).

Draw inside mode automatically creates a clipping mask from the selected object.

Figure 17 – Drawing Modes.

Symbol Enhancements
Illustrator CS5 provides enhanced 9-slice scaling support. You can now directly use 9-slice scaling on symbols in Illustrator making it easier to work with web elements such as rounded rectangle.

Figure 14 – Enhanced 9-slice scaling.

Artboard Ruler Origin and Coordinates

Figure 13 – Shape Builder tool options.

Resolution Independent Effects
With Resolution Independent Effects, raster effects such as drop shadows, blurs, and textures can maintain a consistent appearance across media. Maintain the appearance of raster effects irrespective of any change in resolution setting.

Figure 18 – FXG Options.

Roundtrip Editing with Adobe Flash Catalyst CS5
Use Illustrator CS5 for interaction design, enabled by new Adobe Flash Catalyst CS5, available with all the Adobe CS5 products. Develop ideas and design your interface in Illustrator. Open your artwork in Flash Catalyst and add actions and interactive components, without writing code.

Figure 17 – Drawing Modes.
The Gradient Mesh is more powerful and useful than it’s ever been before. If you use meshes heavily in your design, no more creating masks to get that fading look in your artwork.

Figure 21 – Gradient Mesh Transparency.

ENHANCEMENTS OF THE GRADIENT MESH

The enhancements of the Gradient Mesh are very good. Gradient Mesh nodes can have individual or independent opacity values - meaning you simply select one or more mesh nodes and set an amount of opacity on it from the Transparency/Appearance Panel or the Opacity slider in the control panel.

The Gradient Mesh is more powerful and useful than it’s ever been before. If you use meshes heavily in your design, no more creating masks to get that fading look in your artwork.

Figure 21 – Gradient Mesh Transparency.

DARREN A. WINDER (DAZ),
Graphic designer, web designer, teacher, technical editor of books on Photoshop, Illustrator and PainterX. He can be found at the forums at PhotoshopCafe.com answering questions on Illustrator and Photoshop.

www.dawdesign.com
Adobe announces the release of InDesign CS5, a major upgrade to their flagship page-layout program. While we thought the CS4 upgrade was pretty darn good, the CS5 release is head-and-shoulders better. Not only is the set of major features compelling for both print and interactive designers, Adobe has made dozens of small improvements to workflow and interface that mean big improvements for user experience.

We have to tell you that we are very excited about InDesign CS5. Of course, Adobe didn’t add every feature we wanted, but we think that after reading about the features below, you’ll agree that the upgrade is well worth it.

In the scientific classification of the InDesign CS5 phylum, this upgrade contains two classes: In-activus and MakeItBetterus. Both classes contain rich and diverse families of feature species. Let’s take a look.

INTERACTIVE AND RICH MEDIA STUFF

The biggest set of new features falls into Interac-tivus — the features that make InDesign zoom, pop, and jiggle. You’ll see this from the get-go in the New Document dialog box, in the form of a new Document Intent menu. If you choose Web as your intent (the other choice is Print), InDesign sets up the document for an onscreen audience: the Page Size defaults to 800 by 600 pixels —yes, you can specify size in pixels now, Facing Pages is turned off, Transparency Blend Space is set to RGB, and all color swatches are defined as RGB (though why on earth transparency Blend Space is set to RGB, and all color swatches are defined as RGB (though why on earth)

Because InDesign obviously didn’t have enough panels, CS5 now provides five — count ‘em, five! — new panels related to interactive documents:

PREVIEW PANEL.

Woo-hoo! You can preview page transitions, button rollovers and actions, movies, sound, and the other new interactive features in CS5 right inside of InDesign without having to export the file to PDF or SWF first. Preview just the selected object (such as a rollover), or the active spread, or the entire document. If you’re working on a SWF, you’ll also love the Test in Browser command in the Preview panel menu.

ANIMATION PANEL.

No need to worry about timelines or tweening frames or anything like that — you can animate any InDesign object in response to a page turn or a button action simply and easily with the designer-friendly Animation panel. Just select an object or group and then choose any one of the dozens of built-in motion paths (the same as in Flash CS5 Pro) from the panel’s Preset menu. A little butterfly preview gives you an idea of what the selected motion path does, or you can jump straight to the new Preview panel (described above) to see precisely how your selection will animate on screen.

Animations can only appear in SWFs that you export from InDesign (not PDFs) but here’s our first InDesign CS5 Secret: To get an animation to appear in a PDF, export just the animated object to SWF (Export Selection is a new option in the SWF Export dialog box) and then place that SWF right back into the InDesign layout, replacing the object. When you export the layout to interactive PDF and view it in Reader or Acrobat 9, the animation plays!

TIMING PANEL.

If you have more than one animation on a spread, and all are set to begin on, say, Page Load, how can you control the order in which they play? Answer: By dragging the animation names in the Timing panel in the order you want them to appear. It’s simple and intuitive, once you know where to look. You can even link them in the panel so they play concurrently. No coding required.

MEDIA PANEL.

We now have a central location to manage placed movies, sound, and SWF files. Newly supported formats for placing into CS5 include SWF, FLV, F4V, MP4, and MP3 files, and if you use any of these, you can preview them in the new Media panel. (Older video formats are still supported, but you can’t play them in the panel. However, you can optionally convert them to FLV or F4V before placing them, via the Adobe Media Encoder, which is now installed with InDesign CS5.)

Plus, you can use the Navigation Points section of the Media panel to set precise locations (timestamps) in your movie, as we’ve done (in the image above) for the nav point called “Closeup.” Then you can use new Button actions to allow your audience to quickly jump to those specific points in the movie.

OBJECT STATES PANEL.

The Object States panel lets you create, edit, and manage an entirely new type of object in InDesign called a Multi-state Object. A what?! Well, imagine an object group where only one member of the group is visible at any one time. That’s a multi-state object. The visibility of the objects is controlled either by clicking on the visibility section of the panel — similar to how the Layers panel works — or by the end user in a SWF by clicking buttons. (But-ton actions now include Go to Next State, Pre-view State, and First State/Last State.)

By using multi-state objects for things like slide shows in your SWFs, you allow the end user to “load” different content items in a single object on the pagescreen, without needing to switch to additional pages. Conceivably, you could also create multi-state objects (is it too early to start calling them MSOs?) to make versioning of your non-inter-active and cross-media enhancements you should know about:

CONVERT URLs TO HYPERLINKS.

A new command in the Hyperlinks panel, Convert URLs to Hyperlinks, is like a GREP Find/Change for all URLs and e-mail addresses in your document (or Story, or Selection, just as in Find/Change). InDesign converts them to working hyperlinks and optionally applies a character style of your
chooses to them as it goes. It’s pretty smart about it, too! (However, it’s not as clever as DTP Tools’ URL-2Hyperlink plug-in.)

**EXPORT TO INTERACTIVE PDF.**

This is a big change that is bound to trip some people up at first. If you want your PDF to include the interactive buttons you created, to play the media you imported, and/or to show the page transitions you applied, you have to choose File > Export and choose Adobe PDF (Interactive) from the Format menu in the Export dialog box. There you’ll be able to not only include all those goodies, but you can also set up the view, presentation mode, and layout (e.g., Fit page, Single Continuous, Full screen) for when the PDF is opened in Reader or Acrobat. Yay!

It’s important to note that because of how InDesign creates the PDF, your readers will need Reader or Acrobat v9 to reliably view any rich media you added — they’ll get an alert suggesting they upgrade if they open it in an earlier version.

InDesign CS5 still has the File > PDF Presets menu — with all the same presets as in CS4 — for creating print-worthy PDFs. With this method, though, you’ll find that the only interactive elements you can optionally include in your PDF are hyper-links and bookmarks. It’s kind of weird, but Adobe left out the ability to make Interactive PDF presets.

**IMPROVED EXPORT TO FLASH PROFESSIONAL.**

When you choose Flash CS5 Professional as the Export format, InDesign creates a FLA file (no more XFL files). A new text engine for Flash means that XFL files). A new text engine for Flash means that InDesign CS5 still has the File > PDF Presets menu — with all the same presets as in CS4 — for creating print-worthy PDFs. With this method, though, you’ll find that the only interactive elements you can optionally include in your PDF are hyper-links and bookmarks. It’s kind of weird, but Adobe left out the ability to make Interactive PDF presets.

**IMPROVED EXPORT TO EPUB AND XHTML.**

Did you use <gasp!> local formatting instead of styles anywhere? Don’t worry, local formatting can be maintained when you export to ePUB or XHTML in InDesign CS5. Also, you can tell InDesign to use Page Order or XML Structure to determine the order of exported content. That means if you specify XML Structure, you get a chance to reorder, add, or remove content from the XML structure panel before exporting, giving you more control. We still think that’s a pretty clunky way to handle the export, but it’s far better than nothing.

**IMPROVEMENTS FOR EVERYONE**

While the interactive features are coolio, the majority of InDesign users will be affected more by the huge pile o’ features in the order MakeItBetterus — which can be broken down into existing features that have been improved, and new features that build on the underlying framework that we’re all accustomed to.

**NEW TOOLS**

InDesign CS5 adds two new tools to the Tools panel: The Gap tool and the Page tool.

**GAP TOOL**

While the Selection tool lets you select objects, and the Direct Selection tool lets you target parts of an object, the new Gap tool lets you adjust the gap (“white space”) between two objects. This tool is going to be a huge boon to photographers working on their portfolio sheets, production artists working on catalogs, and anyone else who has images or objects on a grid.

The only problem with the Gap Tool is that you have to remember several non-intuitive keyboard shortcuts to get to the advanced features. Fortunately, InDesign CS5 has a Tool Hints panel that you can open (Window > Utilities > Tool Hints). This gives you tricks for whichever tool you’re currently working on.

**PAGE TOOL (MIXED PAGE SIZES).**

One of the most amazing and helpful features in CS5 is the new Page tool, which lets you change the size of each page in your document — much like the Artboard tool in Illustrator. (In the past, the only way to accomplish this was the Page Tools plug-in from DTP Tools.)

It’s interesting to note that this feature also lets you alter how (or where) a master page is applied to each differently-sized page. This will certainly deserve its own blog article to explain how it works and why you want it, but suffice it to say, it’s nifty!

**GRIDIFY**

The “gridify” option isn’t a new tool, but rather improves all the object-creation tools. For example, if, while you’re drawing a frame, you press the up arrow key on your keyboard, you get two frames (one above the other). Now press the right arrow key and you get four frames (two rows and two columns). It sounds trifling, but it’s awesome when you’re placing multiple files (it works with the Place cursor) or trying to create a grid of any sort.

Gridify also works when duplicating objects with the Option/Alt key, to build sort of a “super step and repeat” effect. Again, we’ll cover that in a future blog article for more details.

**SPRING-LOADED TOOL SHORTCUTS.**

Want a tool temporarily? Just press and hold down its shortcut. Now click or drag with the tool. When you let go of the shortcut, the Tool panel reverts back to the tool you were originally using.

**SELECTING, MOVING, AND MANAGING OBJECTS**

Adobe has taken a number of simple processes, looked at ‘em hard, and made them easier for users.

**SELECTING OBJECTS.**

It has always been possible, but a bit of a pain, to select an object inside a group or an image inside a graphic frame. Now whenever you hover over a graphic frame with the Selection tool you see a "content grabber" (looks like a camera focus, or a bagel). Click it and the image is selected, or just drag it and the image moves inside the frame. It’s extremely intuitive and it’s a great example of how Adobe has fine-tuned and finessed features in CS5, to every InDesign user’s advantage.

Similarly, you can double-click on an object in a group to select it. Double-click again to select the group. You can select two or more objects with the Selection tool and they immediately act like a group: You can scale and rotate them all by dragging on or just outside side or corner handles. (The ability to rotate by dragging the Selection tool just outside a corner handle works for single objects, too, and is...
also new in CS5 — it’s like they merged the Selection tool and the Free Transform tool!

LAYERS PANEL.
At first the Layers panel looks just like it did in CS4, but on closer inspection, you’ll see that each layer has a “swirl-down/expand” triangle next to it. Click that and you can see each object on the layer, much like you can in Illustrator. This is definitely one of our favorite new features in CS5, as it makes it so much easier to select and rearrange objects in a complex layout. You can even create custom names for groups, and hide/show or lock/unlock individual objects on a layer here!

LIVE CORNER EFFECTS.
Everyone likes corner effects — especially rounded corners. Now InDesign makes it easier than ever to apply corner effects to objects, because you can just drag the corners themselves, right on the frame, and even apply different corner effects to different corners in a rectangle.

STROKE/FILL WIDGETS.
The less we have to open and close panels in InDesign, the happier we are, so we’re grinning from ear-to-ear because Adobe added Swatches widgets (one for Fill, one for Stroke, both with Tint fields and this panel menu button) in the Control panel. This means we can leave the Swatches or Color panels closed most of the time!

TEXT AND TYPE
As you might expect from Adobe, some of InDesign CS5’s most impressive new features fall into the area of text and typography.

BALANCED COLUMNS.
You have a three-column text frame, but the text doesn’t fill to the end. You can now “bottom out” all three columns, aligning their lower baselines automatically, by turning on the Balance Columns checkbox in the Text Frame Options dialog box.

COLUMN SPANNING AND SPLITTING.
You want a heading to span (“straddle”) across two or more columns in a multi-column text frame? No problem, with the new Span Columns feature. It’s so great. On the flip side, you can also tell two or more paragraphs to “split” into sub-columns, perfect for when you have a list in a wide column of text.

Spanned headline and split list inside one multi-column frame

NON-RECTANGULAR VERTICAL JUSTIFICATION.
One of the persistent complaints about InDesign over the years has been that its vertical justification (forcing text to fit from the top to bottom of a text frame) stops working in a non-rectangular text frame, or when the text frame has any sort of text wrap applied to it. We’re happy to say this is now fixed. Justify away!

TRACK CHANGES.
Here is another one of our favorite features in CS5. It’s been in InCopy for years, and now it’s finally in InDesign: The ability to track changes to text, review the changes, accept or ignore the changes, and so on. The trick is the new Track Changes panel. This is going to save us so much time! (And if your company is already using InCopy, yes, this means you now have full round-tripped track changes.)

DEFAULT FONT.
Okay, this is a really little one, but we’re very happy to announce that the default font (the font you get when you first install InDesign and make a text frame) is now Minion Pro instead of the problematic Times Roman. Yay!

DOCUMENT FONTS.
You package up your InDesign document and send it to someone else. You’ve included the fonts, but they forget (or don’t know how) to install those fonts on their system, so the document doesn’t appear properly to them, right? That’s the old CS3 and CS4 way… now, in CS5, it works better, because InDesign automatically sees and uses any fonts inside the Document Fonts folder (which has to be in the same folder as the document itself, of course). However, note that these fonts work only in that one document.

BUZZWORD INTEGRAION.
Are you a fan of Buzzword, the collaborative word processor program that’s part of Acrobat.com? We are. In InDesign CS5, Buzzword gets its own File > Place from Buzzword command. You can even choose to link to the Buzzword document, so that as colleagues update the shared file “in the cloud,” you can update your local file in InDesign. (Alas, any formatting you applied to the text in InDesign is lost, just like linking to Word files.) You can also export to Buzzword to create new Buzzword documents in your Acrobat.com account from the contents of InDesign text frames. Neat. Unfortunately, until Buzzword supports paragraph and character styles, this feature will have only limited appeal.

GRAPHICS
InDesign CS5 also has several significant features involving graphics that you should know about.

MINI BRIDGE.
Bridge is a great program, but it suffers from one major problem: it’s a separate program! Wouldn’t it be cool if you could get many of Bridge’s features right inside InDesign? Now you can, with the Mini Bridge panel. You still need Bridge running in the background, but you don’t have to switch apps to get the features you want: searching for graphics, drag and drop to place files, and so on.

There’s one other Bridge/Mini Bridge feature which is astonishing enough that we need to mention it here: You can choose to show an InDesign document in Mini Bridge, then click a button to see all the images linked inside that INDD file! This is great when you know you’ve used an image inside a layout, but you don’t remember the image’s name or where you saved it. You
don't even have to open that InDesign document to get to that same graphic!

LIVE CAPTIONS.
Each version of the Creative Suite has slowly increased the value of XMP metadata in your files. Now, metadata is more important than ever, because InDesign can automatically extract it and place it into a caption text frame on any side of an image. For example, you can make a caption automatically show the image’s file path or text description or copyright information. There were ways to do this before with scripts, but the Live Caption feature makes it so easy, quick, and available to everyone.

DOCUMENT USER EXPERIENCE IMPROVEMENTS
Finally, here’s a list of a few “little” new features in CS5. This isn’t comprehensive, but these are cool enough to deserve a mention.

START PAGE NUMBER.
Newbie InDesign users have struggled for years to figure out how to start a document on a page number other than 1. Now you can do it right in the New Document dialog box.

PRESENTATION DISPLAY MODE.
Want to show your document to your boss or client? Check out the new Presentation display mode (press Shift-W), which is like the Preview mode, but takes up the whole screen, even hiding panels and menus.

COLOR LABELS.
You can now color-code your pages inside the Pages panel, which is helpful to quickly identify page types or sections of a long document.

BACKGROUND EXPORT.
Tired of waiting for a big PDF file to export? Wait no longer, because InDesign CS5 now exports PDF and IDML files in the background. We hope to see even more multi-threading like this in the future.

ZOOM IN DIALOG BOXES.
You can now zoom in and out while a dialog box is open, by pressing Command/Ctrl and plus or minus. This is still not as flexible as Photoshop (which lets you zoom and pan all you want), but it’s a step in the right direction.

WISHING FOR MORE
We applaud Adobe for a great upgrade to our favorite page-layout application. But while we’re clapping with one hand, we’re kvetching with the other. (No, that doesn’t really make any literal sense, but you get the idea.) There are dozens of big- and little-ticket items that InDesign is still lacking. For example:

• No way to create PDF form objects (text fields, checkboxes, etc.)
• No way to apply image sharpening or Curves or other Photoshop effects to an image, like QuarkXPress can do
• Still no way to export a grayscale PDF
• Cannot apply multiple strokes and fills to objects, as in Illustrator’s Appearance panel
• Still no Universal language solution, allowing right-to-left (Hebrew, Arabic, etc.) or vertical text (Japanese, Chinese) in one program
• No way to set page geometry (size, position) in an object style

But remember that it is partly our job to complain about what the program doesn’t do, ever in hopes of seeing these things in CS6… or CS7…

The fact that we want more should not detract from the greater truth that CS5 is a truly great upgrade. Adobe has clearly made it easier and more powerful for all users, and way-way-more powerful for those who need to make interactive documents. We think it is extremely likely that the majority of people who are still using CS2 or CS3 will want to jump quickly to CS5, and CS4 users will also find significant benefits in the upgrade.

ABOUT THE AUTHORS
David Blatner and Anne-Marie Concepción are regarded as the top InDesign experts and have authored a ton of book and spoken at many events. Together they run the top InDesign Resource and magazine InDesignSecrets.com
And that’s not all by a long shot! The Mercury Playback Engine takes multitasking to a new level. Utilizing the GPU to accelerate effects, rendering, and other processor-intensive tasks frees your system’s CPU to handle background tasks. The enhanced native 64-bit system architecture in Adobe Premiere Pro CS5 lets you use all available system RAM (up to 128GB in today's computers) so you can run multiple software applications at the same time. This opens the door to powerful timesaving, multitasking workflows. For example, you can simultaneously edit a very complex, effects-laden project in Adobe Premiere Pro while your system’s CPUs render an elaborate After Effects composition in the background. The improved technology speeds up the processes and allows you to increase your productivity and creativity, in ways that you have never seen before.

Have you ever worked on a computer or laptop that has been brought to its knees by footage or sequences that have a large number of effects? If so, you will love this! The Mercury Playback Engine gives you the ability to adjust the playback resolution of your video in the Source Monitor or Program Monitor. Separate Playback and Pause resolutions give you more control over monitoring. With high-resolution footage, you can set playback resolution to 1/2 for smooth viewing. Setting Pause resolution to Full allows you to quickly check the quality of footage or edges when playback is paused—useful for when you don’t have the luxury of an on-set HD monitor. When working with higher resolutions, such as RED 4K footage, you can set playback resolution to Full allowing you to set playback resolution to 1/2, 1/4, 1/8, or 1/16 for smooth viewing.

EXPANDED NATIVE TAPELESS WORKFLOWS IN ADOBE PREMIERE PRO CS5
Adobe Premiere Pro builds upon the industry’s best native tapeless workflow by offering new native format support for Sony XDCAM HD 50, Panasonic AVCCAM, DPX, and AVC-Intra. In addition, native support has been added for video shot on Canon, Nikon, and other DSLR cameras. Plus, full native support for RED R3D files means you can import them directly without installing additional software. Adobe Premiere Pro lets you combine a wide range of sources—with different resolutions, frame rates, and aspect ratios—in a single sequence without complex format conversions. For example, if you drop a RED R3D clip into an HD sequence, the clip will be automatically cropped to the HD frame size. Similarly, if you drop an SD clip into a sequence in an HD project, the clip will be pillar-boxed automatically. Thanks to the Mercury Playback Engine and broad native format support, mixed-format timelines can be edited in real time. The only time that rendering occurs is when you send your sequence to Adobe Media Encoder for output in virtually any major delivery format.

FAST, ACCURATE KEYING WITH ULTRA
Ultra, the powerful new high-performance keyer in Adobe Premiere Pro CS5, lets you achieve fast, accurate keying on even the most challenging DV and HD footage—footage shot under real-world conditions typically found in production that include uneven lighting, wrinkled backgrounds, and frizzy hair. Ultra preserves shadows and can achieve complex keys on smoke, liquids, and transparent objects. The GPU-accelerated Mercury Playback Engine dramatically increases rendering speeds, usually resulting in real-time HD keying.

FACE DETECTION
Save even more time with Face Detection. By running another content-analysis process on clips in your project, you can quickly locate files with human faces in them. Because these clips are more likely to contain spoken dialogue, Face Detection eliminates the painstaking process of having to play through each clip in a project to find, for example, interview sound bites or establishing shots.

OPEN WORKFLOWS WITH APPLE FINAL CUT PRO AND AVID MEDIA COMPOSER
Moving media and sequences between tools made by different companies in complex production pipelines often requires format conversion, specialized plug-ins, tedious workarounds, or a lot of manual work to recreate elements that don’t survive the transfer process. Interoperability between Adobe Premiere Pro and Final Cut Pro, as well as between Adobe Premiere Pro and Avid NLEs such as Media Composer, means you can share files and timelines without conversion or rendering, preserving commonly used effects and transitions, saving valuable production time.

COLLABORATIVE REVIEW AND APPROVAL WORKFLOWS WITH CS REVIEW
Clients, project managers, and members of production teams don’t always work in the same location, in the same city, or even in the same country. CS Review* provides a fast and simple way for teammates and clients to take part in reviewing video sequences, using just a web browser and easy-to-use annotation tools.

Unlike other services that offer online review of creative content, CS Review lets you publish a review to the web directly from within Adobe Premiere Pro. Encode sequences in the background and automatically upload them for review and collaboration. When colleagues and clients make comments while viewing the content in a web browser, those comments are dynamically captured and displayed directly in the new Review panel in Adobe Premiere Pro alongside the sequence they relate to. Jump directly to comments in the timeline to efficiently
NEW OUTPUT OPTIONS AND METADATA CONTROLS IN ADOBE MEDIA ENCODER

Adobe Premiere Pro lets you produce video optimized for distribution practically anywhere.

Adobe Media Encoder—a separate 64-bit application included with Adobe Premiere Pro CS5—lets you output your video project in all of the major video formats using a flexible batch list. Batch encoding takes place in the background, freeing you to focus on creative work. Its enhanced user interface provides more visual feedback to help you work faster, while the new ability to start the encoding process immediately from within Adobe Premiere Pro without going to the Adobe Media Encoder batch list saves you time.

When batch encoding, you can use any combination of sequences and clips as sources, and encode to a wide variety of video formats, including FLV, F4V, Windows Media, QuickTime, and other popular codecs such as MPEG-2, MPEG-4, and H.264.

WRAPPING UP

Just quick thanks for checking out the awesome new features of Premiere Pro CS5. This release is by far one of the most exciting releases to date and one that is a must have upgrade for all of you Premiere Pro users who want to step up your game.

ABOUT THE AUTHOR

Bruce Bicknell is a video and animation specialist who is the founder of Digital Blue Productions. He has been an Instructor on Adobes in-box training as well as published in Photoshop User, Layers Magazine, ALL REEL, MacTribe and PhotoshopCAFE. His clients include Time Inc., DTCC, KW Media and has worked with magazines that include People, National Geographic, Adventure, Photoshop User, and Layers magazines to name a few. Bruce is also an instructor at Sessions.edu teaching video and graphics courses.

Stay tuned for a new title by Colin Smith. You will learn the HDSLR workflow for photographers. Shoot and edit video in language photographers understand.

www.photoshopcafe.com/video

After Effects is the industry standard for motion graphics and compositing. It is used by video editors as well as motion graphics designers and compositors to create many of the cool graphics that you see in film and television today. No matter if you are using Mac or PC, After Effects is a staple in the workflow. We all know what CS4 brought to the table so with that said what can Adobe come up with to top that? A lot!

This time around, I’m very excited to adopt the new version of After Effects. This version of After Effects is loaded with killer new features that will have you salivating over the possibilities and lining up to get your upgrade. Let’s take a look at these new features and I will give you a rundown of what I think are the best of those new features. Here we go!

NATIVE 64-BIT APPLICATION

This has to be the most important update to After Effects and one that has been on the “wishlist” for many for quite some time. With the newer cameras producing more HD video at higher bpc (bits per channel) the frame sizes are only getting larger and the 32 bit way had to change. We have all been in the position where we up against the limitations and sat by patiently (or impatiently in my case) while we had to wait while our larger projects re-rendered. Well with After Effects CS5 those limitations do not apply! As with the other programs in the suite (Photoshop After Effects now has 64 bit capabilities and what that means to you is that your production capabilities just got a huge shot in the arm. With 64 bit comes the ability to use all of your computers RAM and not only part of it due to the limitations that the older versions gave you. Also, with the new found increase you will find dramatic increases when you are working on your high resolution projects!

A while back, Adobe announced that the next versions of the video products would be 64 bit only (This was so that people would avoid rushing out and getting new 32 bit systems). That’s right all the Production Premium apps are 64 bit. There is no longer support for 32 bit operating systems in CS5 video apps. All the windows users have to upgrade to 64 bit Operating systems to use CS5 (Mac users are already covered for some time now). The performance increase is worth it though.

INTEGRATED MEMORY MANAGEMENT

When you have several Adobe Creative Suite 5 video applications installed in addition to After Effects CS5, you can coordinate RAM allocation for After Effects, Adobe Premiere Pro, Adobe Encore, and Adobe Media Encoder, thanks to cross-component memory management. These memory settings may be accessed inside After Effects by choosing Preferences > Memory & Multithreaded Rendering.

About Colin Smith

Colin Smith is a professional video and motion graphics designer who has been working with Adobe Creative Suite since version 1. Smith is a contributing editor at Photoshop User and Layers magazines to name a few. He is also an instructor at Sessions.edu teaching video and graphics courses.

Stay tuned for a new title by Colin Smith. You will learn the HDSLR workflow for photographers. Shoot and edit video in language photographers understand.

www.photoshopcafe.com/video

Password protection helps to maintain control over who can create a new review, make and view comments as they are posted help you track reviewer participation, respond to comments, or just read comments. The ability to set deadlines, track reviewer participation, match feedback to specific elements, and keep track of review comments in one location.

Because reviews are accessed simply through a web browser, CS Review brings your teammates and clients into the review process in near-real time, regardless of where they are or on what computer they are viewing content. When you need to view or add comments to a review while working offline, all comments are automatically saved in the cloud, and when you are ready, they upload and are ready for your teammates to view.

When you have several Adobe Creative Suite 5 video applications installed in addition to After Effects CS5, you can coordinate RAM allocation for After Effects, Adobe Premiere Pro, Adobe Encore, and Adobe Media Encoder, thanks to cross-component memory management. These memory settings may be accessed inside After Effects by choosing Preferences > Memory & Multithreaded Rendering.

About Colin Smith

Colin Smith is a professional video and motion graphics designer who has been working with Adobe Creative Suite since version 1. Smith is a contributing editor at Photoshop User and Layers magazines to name a few. He is also an instructor at Sessions.edu teaching video and graphics courses.

Stay tuned for a new title by Colin Smith. You will learn the HDSLR workflow for photographers. Shoot and edit video in language photographers understand.

www.photoshopcafe.com/video
cessing (Mac OS) or Edit > Preferences > Memory & Multiprocessing (Windows). This allows you to make the most of your system resources without learning complex memory management settings.

**ROTO BRUSH**

This is one that I know everyone will be excited about! We all have been in a position where we need to separate the foreground object from the background to use in a different project or scene. So what do we do? We jump in and rotoscope the project knowing that it is tedious and time consuming but a necessary evil to get the results we need right? Well yes, until now. The Roto Brush is going to floor you as it provides you with a fast, efficient solution for isolating these foreground elements in new scenes that leaves you with an excellent initial matte for you to work from. Along with that comes the Refine Matte feature that helps clean up the edges around your objects better and faster than you ever could with the manual techniques we are all used to!

In action, this tool really works. You paint a selection, similar to the quick selection brush in Photoshop. After Effects detects the edges and creates a mask. The mask morphs with the shape of the object from frame to frame. It even does a good job where the foreground and background colors are similar. There are tools to tweak the mask. The edges are very smooth and realistic.

**MOCHA**

It is more often than not that our projects require motion tracking and most of us experience the same challenges like tracking elements that partially go out of frame or include motion blur. Well you will be ecstatic to hear that mocha (included with AE CS5) has been significantly updated, making it easier than ever to handle even the most difficult tracking and stabilization tasks. Mocha now has the ability to apply motion tracking to the individual vertices of hand drawn masks that precisely trace an object’s outline. Motion-blurred or semitransparent areas are easily handled with new support for variable-width mask feathers. And like After Effects CS5, mocha for After Effects CS5 is now a native 64-bit application.

**I COULD GO ON AND ON…**

While I would love to go into all of the cool new features of After Effects CS5 in depth here I need to keep the article at a reasonable length. Here are some of the other features that I hope to go over in detail in the upcoming issues of Creative Studio Café.

**AVC-INTRA SUPPORT PLUS EXPANDED RED CAMERA SUPPORT**

Another great new feature is AVC-Intra. After Effects CS5 includes native support for the new AVC-Intra 50 and AVC-Intra 100 codecs, as well as expanded support for footage from RED cameras. Permutations, including 2K, 3K, 4K, 4K HD, 16x9, and 2x1, using a number of different frame rates.

**AUTO-KEYFRAME MODE**

After Effects CS5 now features an Auto-keyframe mode. When Auto-keyframe mode is on, modifying a property automatically turns on that property’s keyframe animation stopwatch, and adds a keyframe at the current time. This prevents you from working with a layer’s properties only to realize later that After Effects didn’t capture any of your changes.

**RED R3D FILE SUPPORT**

If you are working with video and haven’t lived in a hole for the last few years, you will be aware of all the buzz surrounding the RAW empowered RED Cameras. After Effects CS5—like Adobe Premiere Pro CS5—provides full native support for RED R3D files, allowing you to import them directly without transcoding, rewrapping, or installing additional software. You can work with content in all common RED R3D file permutations, including 2K, 3K, 4K, 4K HD, 16x9, and 2x1.

**COLOR FINESSE 3 LE**

After Effects CS5 includes the latest version of one of the most powerful color correction plug-ins available: Synthetic Aperture’s Color Finesse 3 LE. The latest release of this versatile tool introduces numerous...
refinements, including native support for 64-bit operating systems, providing you with new ways to perfect your images.

**COLOR LOOK-UP TABLE SUPPORT**

After Effects CS5 adds support for custom color look-up tables (LUTs) in the popular 3DL and CUBE file formats. This feature is the result of requests from artists using After Effects for high-end film-based workflows, where other tools are also being employed to treat the footage. LUTs exported by a color finishing system, for example, may now be loaded into After Effects CS5 to accurately simulate what the result would look like on a specific piece of footage or in a final composite.

**DIGIEFFECTS FREEFORM**

Digieffects FreeForm—included with After Effects for the first time in Creative Suite 5—vastly increases your 3D design options, allowing you to do more in After Effects without requiring a side trip into dedicated 3D software. This powerful plug-in allows you to bend or warp any layer in 3D space, using either a user-controllable mesh of points or another layer as a displacement map. FreeForm automatically responds to 3D cameras and lights in After Effects, making it easy to integrate the results of this effect into any 3D scene.

**WRAPPING UP**

Just a quick thanks for checking out the awesome new features of After Effects CS5. This release is by far one of the most exciting releases to date and one that is a must have upgrade for all of you After Effects users who want to step up your game.
Follow us on Twitter
#photoshopCAFE

http://www.facebook.com/photoshopcafe

http://www.youtube.com/photoshopcafe

http://www.flickr.com/groups/photoshopcafe/

THE CAFE Forums
http://www.photoshopcafe.com/cafe/